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The Mac® and Windows® accessibility options are similar, but are sometimes found under different names. This
handout focuses on the step-by-step Assistive Technology for Windows®.

Text to Speech in Specific Programs

On computers with Windows®
Microsoft Word 2003°®

Note: It is not possible to read text on web pages but you could copy Web page text and paste it into
Word.

Note: This option has been discontinued in Word 2007 but is still available in Excel 2007.

* Open Word (do this rather than open the Word document from within Internet Explorer from a web
page link, so that the Word menu bar is displayed)

* >Tools 2 Speech

* The “Welcome to Speech Recognition” dialog box is displayed — click Cancel, then OK
(Dictation/Speech Recognition options will be discussed in a later worksheet)

At the top of your Word window this new bar will be displayed Click down arrow for
tions menu

/" Microphone B, Dictation ¥\ ¥oice Command Listening... | % Speak B2Tools H 5 X

Type Correction

- SSaSsE )
[}
Ml
11

4

%

|
11
BT
i
nvi
i

- A ﬁ v Dictation
v /i} Yoice Command

v U Speak Text 4-—

G}y Pause Speaking
v Speech Tools

v Help

Settings...

(2

Restore Defaults

v - ,
* You may need to add the Speak Button | i to the bar; to do this click the Options menu
* Open the Word document to be read aloud. Position cursor where you wish to start.

.

* To start reading back the document from the cursor position, click Speak.
»

* To stop reading, click Stop on the Language Bar.
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1

Speech input settings @ |

Dictation §
. . Mode Keys
To change the type or speed of the voice used for reading back Fe e |
Word documents: e e L e s
Lo assign (hedkeyhnard of mouse action you want to use to switch
. 74 T00ls . etween modes.
* Onthe Language Bar, click Tools & button, Options... .
. lvanced settings
* Click Advanced Speech...button S
H v Automaticall i ds in d ts te il
* Click Text to Speech tab e
° U se VO ice se Iect i ontoc h an g e vo | ce use d ; Save speech data with the document in supporting applications
. v Automatically remove whitespace for punctuation
(there are 3 available) B Diatle etaton whie s
. . [ Playback original audio when correcting
® Use V0|ce speed tO adJUSt the SpeecI IV Allow dictation when correction window is open
= Enable commands in dictation mode
Speech Recognition | Text To Speech Command. | Advanced Speech .. | Language Ba... |

¥ You can control the voice properties, speed, and other options for -
ﬁ{ text-to-speech translation oK l Cancel | |

Voice selection

Microsoft Sam v

Use the following text to preview the voice:

}You have selected Microsoft Sam as the computer's default voice.

Preview Voice

Voice speed
-
Slow Normal Fast

If you have an earlier version of Windows or Word (assuming you have sound capability):
You can install a special application to give you “text to speech” — for example:

* ReadPlease www.readplease.com will let you copy and paste the text you want read (from web,
Word, .pdf doc) into ReadPlease document window before it can be read aloud
* Read and Write www.texthelp.com is more sophisticated and will help you with literacy, too.
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il
Microsoft Excel® 2003 - —
You first need to get customize the toolbar for Text to Speech.
o Customize your Language Bar -

= (Click on> Tools
= - Customize
» - Choose the tab Toolbars
= > Checkmark Text to Speech

Microsoft Excel® 2007
You first need to get customize the toolbar for Text to Speech.
o Customize your Language Bar -

» Click on-> Quick Access Toolbar

= - More Commands

= - Choose All Commands

= Navigate down to Speak Cells

= D Highlight and Add it

= Navigate to Speak Cells =Stop Speaking Cells

= D Highlight and Add it
= Click OK
o Reading Text

= The icons will show in the TOP LEFT hand
corner.

= Click on the cell you want read

= Click on the SPEAK ICON and the text will
be read for you.

New toolbar looks like this

‘j,

v yb i

Home Insert Page Layout f

Cn) d
2/

Paste v | Save

200N U s W N

o T
N O

Customize

Toolbars | Commands = Options

Toolbars:

[Picture 5] e
[PivotTable

[_]Pratection

L_|Reviewing

(] Shadow Settings

[ stop Recording

5 Task Pane'
|| visual Basic

(] watch window
[]web

(] wordart

[v]worksheet Menu Bar

(] Acrobat Connect

[] Acrobat PDFMaker 8.0

[¥] FlashPaper Taolbar v

5
This toolbar is created

and floats on screen

Click on this drop down arrow for
the Quick Access Toolbar

Home Insert]

& Cut
=3 Copy

New

Open

- j Format Painter
r E-mail

Quick Print
Print Preview
Spelling
Undo
v | Redo
Sort Ascending
Sort Descending

More Commands... <——+—

Show Below the Ribbon

Minimize the Ribbon

Visual Accessibility in Microsoft Word® or Excel®-

On computers with Windows®

* Zooming in (enlarging text) > View—> Zoom

* Enlarging Tool Bar 2 Tools=> Customize—> Options—> Click on Large Icons
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Accessibility Options for the Windows Operating System

Locating Accessibility Options in Windows

Click on Start > Programs - Accessories
- Accessibility

1. Accessibility Wizard

i Accessories
(:’] Games
I Microsoft Office »
) Mozilla

1) Mozilla Firefox

{:j Startup

Bl Adobe Stock Photos

& Accessibility

I System Tools
.2 Address Book

=l Caleulator

Click on Start 2 Programs - Accessories = Accessibility 2>

Accessibility Wizard

“This wizard helps you configure Windows for your vision, hearing,

and mobility needs.”

Click next to go to Change Display/Text Size and choose one of three

pre-configured options:
* Keep usual text size
* Use large window titles and menus

Accessibility Wizard

* Use Windows Magnifier and large titles and menus

) Communications

{7 Entertainment

%8 Accessibility Wizard

3 Magnifier

r

s

—

=1 On-Screen Keyboard

[Z] Utility Manager

Welcome to the Accessibility
Wizard

This wizard helps you configure Windows for your vision,
hearing, and mobility needs.

If you are using an input device other than a mouse,
instead of clicking, use the appropriate action to complete
commands or select items throughout the wizard.

To continue, click Next

Use the Accessibil
4" Marrator |your vision, hearil

(Windows Magnifier opens a floating window that

displays enlarged view of part of screen — see more information below)

If you wish to configure your own options, click next and in the “Set Wizard Options” you can change

Impairment Specific Options including:

Vision Options

* Change scroll bar and window size

* Increase icon size

* Choose high contrast display colors to make text easier to se

* Increase size/color of mouse cursor
* Change cursor blink rate/cursor width

Accessibility Wizard

Icon Size
‘You can choose the size of the icons on your desktop.

Select the icon size you want:

Change to Larger

Accessibility Wizard

Display Color Settings
‘You can choose high contrast display colors that make text easier to read.

Select the color scheme you want:
Color schemes: Preview:

Current Color Scheme
High Contrast #1

High Contrast #2
High Contrast Black

High Contrast white

Inactive Window

Active Window
File Edit Help
. ‘Window Text
Change to High

Contrast Display

<Back | New> ] [ Cancel

Icon Size
| =]
@ ::’;’r;;e ey
- Extra Large
{ < Back H Next > ] [ Cancel

Accessibility that is Readily Accessible - Pete & C
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Accessibility Wizard ®

Mouse Cursor
‘You can choose the size and color of your mouse cursor.

Select the mouse cursor that is the size and color you want:

Hearing Options Whe el e

* Have visual warning of system event Change Cursor Size S ﬁj _\j F;J

* Have captions for speech and sounds and Color \A

Mobility Options

* Do key combinations (like CTRL+ALT_DELETE) one key at
a time
Choose to have repeated keystrokes ignored TRTEE WCTE | e
Play sound when certain keys are pressed accidently essihmwwﬂm -
(CAPS LOCK, NUM LOCK, SCROLL LOCK) Mouse Button Settings

* Choose to have extra keyboard help displayed fouconchanashan e e e pncten

* Use numeric keypad instead of mouse You may want to configure your mouse to work with the hand you prefer.

* Choose left-handed mouse instead of right-handed el

* Change speed of mouse pointer \:,Le,,‘handed"' Le_ﬂ:::::.:se.ec.

Administration Options: S e

* Make settings default so that it is on all the time (one Left-Handed/Right-Handed
user) Mouse Button Settings

* Turn off for each new user [ hak || Nob> ]| cowea

2. Narrator (Text to Speech)

To open Narrator, click Start > Programs - Accessories - Accessibility 2> Narrator.

Narrator reads what is displayed on your screen: the contents of the active window, menu options, or the text
you have typed.

* Narrator is designed to work with Notepad, Wordpad, Control Panel programs, Internet Explorer,
the Windows desktop, and Windows setup. Narrator may not read words aloud correctly in other
programs.

*  You can have new windows, menus, or shortcut menus read aloud when they are displayed.

*  You can have typed characters read aloud.

*  You can have the mouse pointer follow the active item on the screen.

*  You can adjust the speed, volume, or pitch of the voice.

Opens a separate window on

. . desk

3. Window Magnifier ... top f
ifi ] B

To open Magnifier, click Start = Programs = Accessories - 5| Magnifier seﬂ. = _@ e

Accessibility > Magnifier. Magnification evel: | KNI .5 fof ke

s impairr
Tracking furctior

Magnifier creates a separate window that displays a magnified
portion of your screen.
* You can change the color scheme of the magnification
window for easier visibility.
* You can move or resize the Magnifier window, or drag it
to the edge of the screen and lock it into place.

Accessibility that is Readily Accessible - Pete & C Sockman & Post
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When using Magnifier, you can:
o Change the magnification level
o Change the size of the magnification window
o Change the position of the magnification window on your desktop
o Invert the screen colors
Magnifier also has a number of tracking options, including:
o Following the mouse pointer as it moves on your screen
o Following the keyboard focus which centers on the location of the cursor
o Following text editing

4. On-screen Keyboard
To open On-Screen Keyboard, click Start > Programs >
Accessories 2 Accessibility 2 On-Screen Keyboard

Note: The program in which you want to type characters

R BREER DGR DM,
ins

must be active while you are using On-Screen Keyboard.

-
NEIEIES
@

On-Screen Keyboard is a utility that displays a virtual keyboard on

the screen and allows users with mobility impairments to type
data using a pointing device or joystick.

On-Screen Keyboard has three typing modes you can use to type data:
* Inclicking mode, you click the on-screen keys to type text.
* Inscanning mode, On-Screen Keyboard continually scans the keyboard and highlights areas where
you can type keyboard characters by pressing a hot key or using a switch-input device.
* In hovering mode, you use a mouse or joystick to point to a key for a predefined period of time, and
the selected character is typed automatically.

In On-Screen Keyboard you can also:
* View an enhanced keyboard that includes the numeric keypad, or a standard keyboard that does not
include the numeric keypad.
¢ Use Click Sound to add an audible click when you select a key.
* Use Always on Top to keep your keyboard displayed on your screen when you switch programs or
windows.

Accessibility that is Readily Accessible - Pete & C Sockman & Post
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Lists accessibility programs being used —

5. Utility Manager
You can also open Utility Manager by clicking Start - Programs - Accessories
- Accessibility = Utility Manager.
Note: You will have limited program management capabilities. You will
only be able to start or stop accessibility programs from within Utility
Manager.
Utility Manager enables users to check an accessibility program's status and start
or stop an accessibility program.
* Users with administrator-level access can designate to have the program
start when Utility Manager starts.
* The built-in accessibility programs available from the Utility Manager are
Magnifier, Narrator, and On-Screen Keyboard.
* By default, Narrator starts when Utility Manager opens. This gives users who Narrator starts automatically
are blind or have impaired vision immediate access to Utility Manager. when Utility Manager is used

can start or stop from here

You can also access many of these accessibility options by going to the Control Panel and clicking on

Accessibility Options. l

6. To adjust the volume:

* Double-click on the 4 Speaker icon bottom right on
the Taskbar
* This will open the Volume Control Dialog box to allow you to adjust the volume

i1 Volume Control

Options  Help

Wolume Control Wave SW Synth CD Player
Balance: Balance: Balance: Balance:

Pl d B~} 4 b4 Do) 4
Volume: Volume: Yolume: Volume:
1} B | J
aiid

[ Mute all [ Mute [ Mute [ Mute
SigmaTel Audio

Accessibility that is Readily Accessible - Pete & C Sockman & Post
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The Mac® and Windows® accessibility options are similar, but are sometimes found under different names. This
handout focuses on the step-by-step Assistive Technology for Mac OX®.

Text to Speech in Specific Programs Mac OX®

oh
H ® m Insert Format Font Tools Table Window Work H
Microsoft Word 2008 Draft {Compatibility Mode]
Web Layout 5 A3
Outline C\TI T@ Lszo% o]
T arout 3n Gallery Toolbox = Zoom  He
4 Open Word !VN:;Tebgz:uLayout || smartan Graphies | we
Publishing Layout ] 8
* Select the text you want to hear o ke '
* Click on View->Toolbars > Speech )/ [E Formatting Palette
. . (52 Object Palette
At the bottom this box will appear: | i Cratons
| Scrapbook
0O Speech 14 |ii#l Reference Tools %R
4, Compatibility Report
Speak Selection 1 E5 Project Palette
Elements Gallery
¥ Standard fte
( Customize Toolbars and Menus... Formatting
Navigation Pane Contact
i Reviewing lica
v Ruler Tables and Borders
Header and Footer
AutoText
v Markup Background
Reveal Formatting Database
-~ Full Screen Drawing
Zoom... Forms
% Movie
* Click Speak Selection e

Hint: The computer always begins reading from the beginning of the selected text. To start at another location,
select a different block of text.

Other Microsoft Office® Applications

Word is the only Office application that has the Speech toolbar. However, any Office application can read text
aloud by using the Mac OS X Text to Speech feature.

) Y Finder File Edit View
* Onthe Apple menu, click Systems Preferences " About This Mac
* Under Systems, click Speech Software Update...

e On the Text to Speech tab, select the L R

Speak selected text when the key is pressed

Dock >
060 Speech ) Location |

[« »|[ Showal | Q|

Speech Recognition | Text to Speech ‘

System Voice: = Vicki _C!
Speaking Rate: =" ( Play ) e = -
T ; = > & i
Slow Normal Fast w — / @
Speech Startup Disk Universal
) - . Access
Announce when alerts are displayed Set Alert Options

Announce when an application requires your attention
—’_ Speak selected text when the key is pressed Set Key

To have clock announce the time: ( Open Date & Time Preferences... )

To change VoiceOver settings: [ Open Universal Access Preferences... )

Sockman & Post
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Press the keyboard shortcut that you
want to use to hear text read aloud (for
example, $+0OPTION + R), and then
click OK.

In any Office Application, select some
text and then press the keyboard
shortcut to hear the text read aloud.

Note: To start or stop reading selected text
aloud, press the Text to Speech keyboard
shortcut that you created.

| <

|| Show All

Speech

Set a key combination to speak selected
text.

Type one or more modifier keys (Command, Shift,
Option, or Control) and another key below. Use this
key combination to hear your computer speak
selected text. If the computer is speaking, press
the keys to stop.

Systen

Speaki'/v Command+Option+R _Play
( Cancel ) ( OK
__ Announce when alerts are displayed
__ Announce when an application requires your attention
¥ Speak selected text when the key is pressed ( Set Key...
To have clock announce the time: [ Open Date & Time Preferences... )

To change VoiceOver settings: [ Open Universal Access Preferences...

L

To change the type or speed of the voice used for reading back documents:

On the Apple menu, click Systems Preferences

Under Systems, click Speech

On the Text to Speech tab, you can change the

speaking rate, system voice and more.

CXGNS Speech
[« »|[ Showal | Q|
Speech Recognition | Text to Speech ‘
—> System Voice: = Vicki T‘
i . P
Speaking Rate: v ‘
Slow Normal Fast

Announce when alerts are displayed
Announce when an application requires your attention

|_|Speak selected text when the key is pressed

Play

To have clock announce the time:

To change VoiceOver settings: |

( Open Date & Time Preferences... )

Open Universal Access Preferences... )

Visual Accessibility in Microsoft Word® or Excel®

Zooming in (enlarging text)
- View—> Zoom

Accessibility that is Readily Accessible - Pete & C
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Accessibility Options for the Mac OX Operating System

Locating Accessibility Options in Mac OX A Finder File edit view

About This Mac
Software Update...

* Onthe Apple menu at the top left of your screen, click System Mac OS X Software...
Preferences
Dock >
Location >
or click on the icon on the dock
i
* Under System, click Universal Access. -
Universal
Access
e o . . e6-C Universal Access
Vision — Use Zoom for easier reading (=) (Foman) al
i On the seeing Tab, Under Zoom, C“Ck on_ When using this computer, | would like assistance with:
(Seeing | Hearing Keyboard Mouse
* Tozoomin, press $+ OPTION + = VoiceOver: Turn voiceOver on or off: %F5
O On @ Off Open VoiceOver Utility... )
* Tozoon out, press Zoom: Turn zoom on or off: 888
& + OPTION + - XOn=@Of Zoom out: % Coptions..)
Display: Switch to white-on-black: 848
* To “toggle” the zoom feature on and off, use the keyboard @Black on White [ Use grayscale
shortcut 88+ OPTION + 8 - White on Black
Enhance contrast: G
Normal Maximum
Note: This utility is useful for trainers who want to highlight a specific Reduce contrast: X4,

£ ind Increase contrast: 8°\CA.
parto a WINdow.

_Enable access for assistive devices

Vision — Change Display for easier reading
* On the Seeing Tab, under Display, you can enhance contrast and change to white on black.

Accessibility that is Readily Accessible - Pete & C Sockman & Post >
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Hearing Options —

* Have visual warning of system event by going to

Universal Access and clicking on Hearing.

eon

| < » || Showall |

Universal Access
Q|

When using this computer, | would like assistance with:

Seeing | Hearing @ Keyboard Mouse

"I Flash the screen when an alert sound occurs

Test the screen flash: ( Flash Screen ) "/

* Click on Flash the screen when an alert sound occurs.

Mobility Options

* Do key combinations (like
CTRL+ALT+DELETE) one key
atatime

* Choose to have repeated
keystrokes ignored

* Play sound when certain keys
are pressed accidently (CAPS
LOCK, NUM LOCK, SCROLL
LOCK)

* Choose left-handed mouse

e 60

[ <

| [ Show All |

To raise or lower the volume, use Sound preferences: (Adjust Volume... )

I Enable access for assistive devices

Universal Access

Q|

When using this computer, | would like assistance with:

' Seeing

Hearing | Keyboard | Mouse

For difficulties pressing more than one key at a time

Sticky Keys: () On @ Off

Treats a sequence of modifier keys as a key combination.

"I Press the Shift key five times to turn Sticky Keys on or off
!Z‘ Beep when a modifier key is set

@ Display pressed keys on screen

For difficulties with initial or repeated keystrokes

instead of right-handed
* Change speed of mouse
pointer

Universal Access

|« » || ShowAll |

Ql

When using this computer, | would like assistance with:

Seeing Hearing Keyboard | Mouse |

For difficulties using the mouse
Mouse Keys: () On @ Off
Use the keyboard in place of the mouse
| Press the Option key five times to turn Mouse Keys on or off
To control mouse pointer movement:

Initial Delay:

' Y '

Short Long

—

Y
Medium

Maximum Speed:
o

i
Slow Fast

For difficulties seeing the mouse

Cursor Size: &
o ! !
Normal Large

To enable full keyboard access: ( Open Keyboard Preferences... )

_Enable access for assistive devices

Accessibility that is Readily Accessible - Pete & C
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Slow Keys: TJon @ off
Puts a delay between when a key is pressed and when it is accepted.
@ Use click key sounds

Acceptance Delay:

Y 1

i
Long Short

1 be set or turned off in Keyboard preferences: / Set Key Repeat... \

(=~ )

for assistive devices
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e o6 Universal Access
[« »|[ showal | Q

Voice-Over (Text to Speech) =

When using this computer, | would like assistance with:

f Seeing | Hearing Keyboard Mouse

. . , -
VoiceOver is Mac’s built-in screen reader. VOiceOVer: Turn VoiceOver on or off: %F5

”4' OOn ®Off ( Open VoiceOver Utility... )
To open turn Text to Speech on, click System Preferen >
. P P . ’ sys e eterences Zoom: Turn zoom on or off: $8X8
Universal Preferences - Seeing—> VoiceOver—> On -~ On ®Off Zoom in: 3\ =
Zoom out: &\ ( Options... )
VoiceOver will read aloud what is displayed on your screen: text in Display:  switch to white-on-black: %\~8
. . . @ Black on White [ Use grayscale
documents, webpages, email; the contents of the active window, menu - White on Black
options, or the text you have typed. Enhance contrast: G————————
*  You can use VoiceOver Utility to customize VoiceOver to ormal o dmam
. . ] . Reduce contrast: Be\i‘, =
suit your needs. As simple to use as iTunes, VoiceOver Increase contrast: #\.~. @
Utility presents a list of nine categories, from General to CEnable access for assistive devices
Braille.

* VoiceOver is designed to work with Microsoft Office® Applications, System programs, Safari, etc.

*  You can have new windows, menus, or shortcut menus read aloud when they are displayed.

*  You can have typed characters read aloud.

*  You can have the mouse pointer follow the active item on the screen.

* Mac OS Xincludes various male, female, and novelty voices you can use to speak a selection or text
or an entire document. You can adjust the speed, volume, or pitch of the voice.

* A highly useful solution for those with cognitive disabilities, Text-to-Speech (TTS) technology allows
them to hear a word as well as see it onscreen.

o ge . e06cr Dock
Dock Magnification B g q
The dock offers a convenient way to access commonly used applications, files Dock Sz e
and folders. The Dock can become quite small if you add a lot of items. You S -
can set the default size of Dock icons so they are easier to see by going to e e o
System Preferences 2 Dock . c' :j A
¥ Animate opening applications
On-screen Keyboard @3 B
i v EE US. D>
To open On-Screen Keyboard, click Apple = System Preferences = N
. . 1 J [] Show Character Palette
International - Input Menu —>Keyboard Viewer IL. | B show Keyboard Viewer B

Then click in the upper right systems toolbar and select the US Flag icon and International 4 E

Show Input Source Name
then Show Keyboard Viewer. Open International...

000 Keyboard Viewer (U.S.)
esc |FL|F2|F3|F4|F5|F6|F7|F8|Fa |F10|F11/F12|F13 F14|F15|F16 Note: The program in which you want to
12/ 395/6/7/8/9/0]/-|=|<& DI\ | # @ = [/ * type characters must be active while you
= (qgiwlefrjtjyjufijolp[l]]]\ ® N~ ¢ 7 8 9 - areusing On-Screen Keyboard.
@ a s df gh j k| = 4 5 6 + On-Screen Keyboard is a utility that
g z | x clv binim , | . /S : L 2 3 . displays avirtual keyboard on the screen
TN | =8 58 0 |. and allows users with mobility impairments
Font: | Lucida Grande B to type data using a pointing device or

joystick.

Accessibility that is Readily Accessible - Pete & C Sockman & Post (\/\
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Adobe PDF — Mac® & Windows ®

Adobe® PDF files (version 9)

e Open Adobe Reader o
* Open the .PDF file from within Adobe e

Reader than from within Internet Explorer
from a web page link, so Adobe Reader
menu bar is displayed

Eull Screen Made

Menu Bar
Toobars

Mavigation Panels

* Click on View = Read Out Loud 2> =
Activate Read Out Loud -
Line Weights

*  For more options, click on View 2 Read
Out Loud to select Read this Page only or

Automatically Scroll
Read Out Loud

B amandalee. pdf - Adobe Acrobat Professional
File Edit B7Z0N Document Comments Forms Tools Advanced Window Help

Read to the End of the Document or
Deactivate, Pause or Stop

To change the type or speed of the voice used for reading
back PDF files:

Windows®

* |n Adobe Reader, 2 Edit menu, > Preferences

* 2/9/09Adjust the settings under “Reading”

* Here you can change the voice used; there are 3
available (same as Windows); what to read and the
volume.

Mac®

' Ol Startesting + (i Secure - A sign + || Forms + 7 Review & Comment ~
» - r
4 i AL B @ @ | 100% |~ = =
; TN =
»
Ctrl+H
Chri+l
Fa
»
»
chu 3, CD ROMs
Shift+Ctri+U
kR 5t 2, 2005). National Geographic: really wild animals - totally
ropical rain forest [Motion Picture]. United States: National
ars  Beographic Video.
Shift+Ctrl+H
Deactivate Read Qut Loud Shift+Ctri+Y
Read This Page Only. Shift+Chri+y
Summ Read To End of Document. Shift+Ctrl+8
This D ) the rainforest. They meet jaguars,
frogs, i ul and fun look in to the world of the
rain forest.

Preferences

Categories: Reading Order Options

Commenting -~
Documents

Full Screen

General

Page Display

Reading Order: | Infer

Screen Reader Options

» Page vs Document: | F
Accessbiity

[[JOverride the reading order in tagged documents

of pages Jso

reading order from document (recommended) v

or large documents, only read the currently visile pages

Search

Senwiy.

Catalog [Z] Confim before tagging documents
Color Management

Convert From POF

Comrart 7o PO Read Out Loud Options

Forms volme: |7 v

Identity

International [Fuse default voice

Internet

Javascript

oot Eﬁﬁ; Use default speech attrbutes
Meeting

Wulimedia

Multimedia Trust TR
New Document

Online Services [JRead form fields

Reading

Reviewing

* In Adobe Reader, select & Acrobat, and then = Preferences

* Adjust the settings under “Reading”

* Here you can change the voice used; there are 3 available (same as Mac); what to read and the

volume.

If you have an earlier version of Adobe Reader (assuming you have sound capability):
d Adobe Reader version 9 is freely available and can be downloaded from:

http://www.adobe.com/products/acrobat/readstep2.html

Accessibility that is Readily Accessible - Pete & C
Page 15

Sockman & Post



Free Web Page reader, WebAnywhere
http://webanywhere.cs.washington.edu/

Press enter. The page will be read for you.

£ ebaryhere e egon i

Open the web page. In the WebAnywhere address bar, type the web address you would like to visit.

WebAnywhere

A Screen reader on the go

Type the of the page ' o =)
you want read here
1etobe rstalod onth
ot ey heppan o pane
e S8 WokametoWebAnphers
WebAnywhere Alpha Release!
WeoAryuters il on o S ———
iy S s solotia
Alpha Release!

WebAnyhers has besn nitalized 21c s now ready 1o Use.

We've relsased WebAryhara 25 an Alpha Release, and s recarty faceived 2 0t of atertion! Despite
orme min Ve

e fight nthe br
WebAmyhere NS T far sunived the onslzught of Wsiors relaively unscathe:

o nstaledt
evon hoaul lcked dos
" o o
olher screen resders, uh as JAWS or incioveEyes,
brow
Trythe WebAnywhere Alpha Release slece s an Apha release i mears
E 210 ad oS, 50you should
Wovie v
Belowis 2 deo rocicion o Web Ay YouTube.Iyou prefar an audo-onlversion of s
content, you can sten o e Audio Des i

7 commands i are cuterty
ern raverses the direction o he search, searching
e you can yoe & URL tovist,

For more general information on accessibility options:

Options include increasing text size, changing screen colors, adjusting keyboard and mouse settings

For tailoring the Windows and Web environment see:

BBC website “My Web for Windows” http://www.bbc.co.uk/accessibility/win/sub root.shtml
Microsoft’s accessibility site http://www.microsoft.com/enable/

For tailoring the Mac and Web environment see:

BBC website “My Web for Mac” http://www.bbc.co.uk/accessibility/mac/sub root.shtml
Apple’s accessibility site http://www.apple.com/accessibility/

Final Note: The accessibility tools that ship with Windows and Mac are intended to provide a minimum level
of functionality for users with special needs. Most users with disabilities will need utility programs with more
advanced functionality for daily use.
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